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PSoC®模拟协处理器入门 

作者： Rajiv Badiger 

相关器件系列：CY8C4Axxx 

相关代码示例：CE211283 

相关应用笔记：AN211294 
  

更多代码示例？我们明白。 

如需寻找包含上百 PSoC 代码示例并有不断更新的网上资源，请浏览我们的代码示例网页。您还可

以在此处观看 PSoC 视频库。 

AN211293 对 PSoC®模拟协处理器进行详细说明，有助于您实现自己的第一个设计。PSoC 模拟协处理器是一个单芯片

的解决方案，它集成了各模拟前端模块（AFE）、带信号处理引擎的各模数转换器（ADC）和数模转换器（DAC）以及

一个主机处理器的通信接口。本应用笔记为您提供了额外资源的概览，以便加快您熟悉该设备的过程。 
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1 简介 

PSoC 模拟协处理器提供了集成可编程的模拟前端（AFE）的可升级且可重新配置的架构，从而简化了基于传感器的设

计。通过使用信号处理引擎（32 位 ARM® Cortex®-M0+），您可以校准和调校软件中的 AFE。 

另外，通过 PSoC 模拟协处理器还可使各种设计通过串行通信接口将聚集、预处理和格式化的传感器数据发送给各主

机处理器。 

一般情况下，根据模拟传感器的输出电信号，可将其分成五种类型：电压、电流、电阻、电容和电感传感器。其中，每

一个传感器类型都需要一个特定的 AFE 设计。例如： 

▪ 热电偶（即电压输出温度传感器）需要一个仪表放大器 

▪ 光度传感器（即电流输出传感器）需要一个互阻放大器（TIA） 

使用多个传感器的系统经常需要多个特定的 IC 来实现 AFE，这加大了物料清单（BOM）费用和 PCB 的尺寸。IoT 应

用的系统设计必须组合多个传感器中的数据，以创建新的感应能力（通常称为传感器融合）。传感器融合的解决方案通

常需要多个定制的 AFE。PSoC 模拟协处理器减少了对特定 IC 的需求，进而允许您在单芯片的解决方案中创建定制的

AFE。 

图 1 显示的是一个基于传感器系统的通用模块框图。该手册包括： 

1. 一个模拟前端（AFE）电路，通过放大和过滤信号来调理传感器输出。 

2. 一个模数转换器（ADC）或比较器（图中未显示），用于将调理的传感器输出转换为数字数据。 

3. 一个带有串行通信接口的可编程的信号处理引擎，用于格式化传感器数据并将其发送给主机处理器。 

图 1. 基于传感器的系统 

 

本应用笔记为您介绍了 PSoC 模拟协处理器的性能，并提供了一个简单的设计，便于您熟悉该器件。在赛普拉斯的

CY8CKIT-048 套件中，该设计便是代码示例 CE211283。 

相关应用笔记和代码示例一节提供了一套丰富的文件，用于加快您的学习过程。它也包括高级应用笔记 AN211294 — 

使用 PSoC 模拟协处理器实现 AFE。 
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2 PSoC 资源 

赛普拉斯的网站 www.cypress.com 上提供了大量资料，这些资料有助于您正确选择 PSoC 器件用于设计，并使您能够

快速和有效地将器件集成到设计中。有关资源的完整列表，请参考 KBA86521 — 如何使用 PSoC 3、PSoC 4、PSoC 

5LP 和 PSoC 模拟协处理器的资源进行设计。下面提供了一个简要的列表： 

▪ 概况：PSoC 产品系列、PSoC 产品路线图 

▪ 产品选型： PSoC 1、PSoC 3、PSoC 4、

PSoC 5LP 或 PSoC 模拟协处理器。此外，

PSoC Creator 还包含了一个器件选择工具。 

▪ 数据手册说明并提供了适用于 PSoC 3、

PSoC 4、PSoC 5LP 和 PSoC 模拟协处理器

系列的电气规格。 

▪ CapSense®设计指南：了解如何使用 PSoC 3、

PSoC 4、PSoC 5LP 和 PSoC 模拟协处理器

系列器件的资源设计电容式触摸感应应用。 

▪ 应用笔记和代码示例：包含了从基本到高级的广泛主

题。许多应用笔记还提供了代码示例。 

▪ 技术参考手册（TRM）：对每种 PSoC 3、PSoC 4、

PSoC 5LP 和 PSoC 模拟协处理器系列中所使用的架构

和寄存器进行了详细说明。 

▪ 开发套件：CY8CKIT-048 PSoC 模拟协处理器 Pioneer

套件是一种易于使用且廉价的开发平台。该套件可作为

独立的套件或 Arduino 屏蔽使用。 

3 PSoC Creator 

PSoC Creator 是一个基于 Windows 的免费集成开发环境（IDE）。通过它可以同时对 PSoC 3、PSoC 4、PSoC 5LP

或 PSoC 模拟协处理器系统进行硬件和固件设计。如图 2 所示，通过 PSoC Creator，您可以进行以下操作： 

1. 将组件图标拖放到主要设计工作区中，以进行

您的硬件系统设计。 

2. 对您的应用固件和 PSoC 硬件进行协同设计。 

3. 使用配置工具配置各组件。 

4. 了解包含一百多个组件的库。 

5. 查看组件数据手册 

图 2. PSoC Creator 特性 

 

 

 

http://www.cypress.com/
http://www.cypress.com/
http://www.cypress.com/knowledge-base-article/how-design-psoc-3-psoc-4-and-psoc-5lp-kba86521
http://www.cypress.com/knowledge-base-article/how-design-psoc-3-psoc-4-and-psoc-5lp-kba86521
http://www.cypress.com/psoc
http://www.cypress.com/product-roadmaps/cypress-psoc-and-mcu-portfolio-roadmap
http://www.cypress.com/products/psoc-1
http://www.cypress.com/search/psg/1292
http://www.cypress.com/search/psg/1297
http://www.cypress.com/search/psg/1307
http://www.cypress.com/products/psoc-analog-coprocessor
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=resource_meta_type%3A575
http://www.cypress.com/documentation/application-notes/an75400-psoc-3-and-psoc-5lp-capsense-design-guide
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide
http://www.cypress.com/documentation/application-notes/an75400-psoc-3-and-psoc-5lp-capsense-design-guide
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=resource_meta_type%3A574
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A579
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=resource_meta_type%3A583
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A577
http://www.cypress.com/CY8CKIT-048
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
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3.1 PSoC Creator 帮助 

请访问 PSoC Creator 主页下载 PSoC Creator 的最新版本。启动 PSoC Creator，并导航到下列各项： 

▪ Quick Start Guide（快速入门指南）：依次选择 Help > Documentation > Quick Start Guide。本指南提供了开

发 PSoC Creator 工程的基本知识。 

▪ System Reference Guide（系统参考指南）：依次选择 Help > System Reference > System Reference Guide。

该指南列出并描述了 PSoC Creator 所提供的系统功能。 

▪ Component datasheets（组件数据手册）：右键点击某个组件，然后选择 Open Datasheet 项。请访问 PSoC 模

拟协处理器组件数据手册网页，以获取 PSoC 模拟协处理器组件的数据手册列表。 

▪ 文档管理器：PSoC Creator 提供了一款文档管理工具，有助您寻找和查看文档资源。要想打开文档的管理工具，请

选择菜单项：Help >Document Manager。 

3.2 技术支持 

若有任何疑问，我们的技术支持团队很乐意为您提供帮助。您可以在赛普拉斯技术支持页面上创建一个技术支持请求。 

如果您在美国，可以通过拨打我们的免费电话，直接与技术支持团队联系：+1-800-541-4736。选择提示符处的第 8 项。 

若想获得快速支持，您同样也可以使用下面的支持资源： 

▪ 自助 

▪ 所在地销售办事处 

http://www.cypress.com/
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
http://www.cypress.com/?id=4749&rtID=377
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A532
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A532
https://secure.cypress.com/myaccount/?id=25&techSupport=1&source=an79953
http://www.cypress.com/support
http://www.cypress.com/?id=1062
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4 代码示例 

PSoC Creator 包含了大量的代码示例工程。可以从 PSoC Creator

的“Start Page” （起始页）上获取这些工程，如图 3 所示。 

这些示例工程通过向您提供完整的设计（并非一个空白设计），从

而加快您的设计进程。示例工程还介绍了如何将 PSoC Creator 组

件使用于不同应用中。此外，您还可以找到各代码示例、数据手册

（在 Documentation 选项卡中）和相应的样品代码，如图 4 所

示。 

在图 4 显示的 Find Example Project（查找示例工程）对话框中现

在有几个选项： 

▪ 根据 architecture（架构）或 device family（器件系列）（例

如 ： PSoC 3 、 PSoC 4 、 PSoC 5LP 或 PSoC Analog 

Coprocessor）、category（类型）或 keyword（关键词）等选

项对示例进行筛选 

▪ 从 Filter Options（滤波选项）的示例菜单中进行选择 

▪ 通过 Documentation（文档）选项卡，查看选出的数据手册。 

▪ 查看所选的代码示例。您可以复制该窗口中的代码然后将其粘

贴到您的工程内，从而加快代码的开发过程，或 

▪ 根据已选工程创建一个新的工程（若需要可添加新的工作

区）。通过为您提供一个完整的基本设计，它可以加快您的设

计过程。然后，您可以根据自己的应用更改该设计。 

图 3. PSoC Creator 中的代码示例 

 

图 4. 附带代码的代码示例工程 

 

http://www.cypress.com/
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5 PSoC 模拟协处理器功能集 

PSoC 模拟协处理器包含丰富的模拟功能和其他资源，如图 5 所示： 

图 5. PSoC 模拟协处理器框图 

 

下面的内容列出了 PSoC 模拟协处理器的主要特性。更多有关信息，请参考器件数据手册、技术参考手册（TRM）、

相关应用笔记和代码示例的内容。 

工作电压范围和可用的低功耗模式 

• 宽工作电压范围：1.71 V 到 5.5 V 

• 睡 眠 模 式 断 开 各 时 钟 与 CPU 的 连 接 。 

时钟频率为 12 MHz 时，电流典型值为 3.1 mA。 

• 深度睡眠模式可支持模拟系统正常操作。 

电流典型值为 2.5 µA。 

可编程模拟模块 

• 通用模拟模块（UAB） 

可以将 UAB 配置为以下配置类型： 

o 12 位缓冲电压的数模转换器（VDAC），采样

率为 500 kHz 

o 二阶双二阶滤波器，如带通、高通、低通和陷波

滤波器 

o 12 位 delta-sigma 模数转换器（ADC），采样率

为 7.8 Ksps，微分非线性误差（DNL）为±1 LSB 1 

o 14 位增量型 Delta-Sigma ADC ，采样率为

100 sps，DNL 为±2 LSB 1 

• 4 个可编程的运算放大器 

o 90 dB 的开漏增益，轨对轨运放 

o 可跟外部组件一同使用，组成标准的运算放大

器电路 

o 可以使用一个内部电阻阵列来组成一个可编程

增益放大器（PGA），支持增益高达 32 

o 驱动各个外部 I/O（高达 10 mA）时，可获得

6 MHz 的增益带宽 

o 驱动各个内部节点（如 SAR ADC）时，可获

得 8 MHz 的增益带宽 

o ±1 mV 的输入偏移电压 

o 深度睡眠模式下的工作电流为 15 µA 

• 两个低功耗的比较器（CMP） 

o 从低功率模式唤醒器件： 

 
1 支持该特性的组件将在 2016 年的下半年上市。 

P
ro

gr
am

m
ab

le
 In

te
rc

on
n

ec
t a

n
d

 R
o

u
ti

n
g

GPIO/
Smart 
I/O x8

PSoC® Analog Coprocessor

SCB x3

TCPWM x8

12-bit SAR

Universal Analog Block

CMP
x2

I/O SubsystemProgrammable Analog Blocks

GPIO 
x8

GPIO 
x6

Opamp 
x4

GPIO 
x8

GPIO 
x8

WCO

Cortex®-M0+

48 MHz

Analog 
Filter

12-bit 
VDAC

14-bit 
Delta-
Sigma CapSense

7-bit 
IDAC

7-bit 
IDAC

AMUX
x38

Signal Processing Engine

Flash 
(16KB to 32KB)

SRAM
(2KB to 4KB)

DMA

10-bit 
Single-slope 

ADC

PRB

http://www.cypress.com/


 
 

PSoC®模拟协处理器入门 
 

www.cypress.com 文档编号：002-12470 版本*A 7 

• 12 位 SAR ADC 

o 高达 1 Msps 的采样率 

o 可选的 8 位、10 位和 12 位分辨率 

o 支持 16 个输入通道的自动硬件定序器 

o 可以将每个通道设置为差分或单端 

o 每个通道上均有自己的集成硬件 

o 可编程输入通道，如外部引脚、运算放大器和
UAB 

• 单斜率 ADC 

o 可选的 8 位和 10 位分辨率 

o 采样率高达 11.6 ksps（10 位分辨率） 

o 所有 GPIO 引脚上的输入测量范围为 VSS 到
VDDA 

o 在 CapSense 模块中实现 

• 可编程的参考模块（PRB） 

o 四个参考电压，可在 16 个步长的范围内独立对

它们进行调整：从 VDDA 到 VSS 或从 1.2 V 到
VSS 

o 可以将这些参考电压布线到内部高阻抗的模拟资

源：ADC、VDAC、比较器和运算放大器。 

o 另外，如果通过运算放大器缓冲参考电压，那么

还可以将其布线到某个 GPIO 上。 

• CapSense® 

o 用于测量电容；可将它和电容式传感器（如液位

或触摸感应应用）一同使用 

o 包括两种：自电容和互电容的感应方法 

o 通过使用扩频时钟和可编程的转换速率控制来降

低电磁干扰（EMI） 

• IDAC 

o 用于 CapSense 或其他通用目的的应用场合的

两个 7 位电流 DAC（IDAC） 

o 通过并行结合两个 IDAC，可创建一个 8 位的
IDAC 

o 37.5 nA LSB 的电流，用于精确的电容测量 

o 在拉电流和灌电流配置中，可以选择六个输出

电流范围中的一个（从 4.76 µA 到 609 µA） 

32 位信号处理引擎 

• ARM Cortex-M0+ CPU，最高 48 MHz 

• 高达 32 KB 并带有读取加速器的 Flash 

• 高达 4 KB 的 SRAM 

• 8 通道的直接存储器访问（DMA）控制器 

• 时钟晶体振荡器（ WCO ），用于实时时钟

（RTC）应用 

• 三个串行通信模块（SCB），可配置为 SPI、I2C

或 UART 

• 八个 16 位定时器 / 计数器脉冲宽度调制器

（TCPWM）模块 

I/O 子系统 

• 多达 38 个 GPIO，可用于模拟、数字、CapSense

或段式 LCD 功能 

• 可编程驱动模式和转换速率 

• 8 个智能 I/O，用于在各引脚信号上实现 Boolean

运算 

5.1 PSoC Creator 组件定义 

对于成功的 PSoC 设计，最关键的就是 PSoC Creator IDE。PSoC Creator 将 PSoC 外设和其他资源组织为各个图形

元素（又称组件）。将各组件拖放到原理图内并将其连接起来，这样会使硬件设计过程显得更加简单，并能够缩短设计

时间。只用点击几下就可以快速更改设计。 

以下组件都适用于使用可编程模拟模块的设计: 

▪ 可编程增益放大器（PGA）和运算放大器 

▪ 电压数模转换器（VDAC），在 UAB 中实现 

▪ 扫描的 SAR ADC，通过 SAR ADC 实现 

▪ 可编程的 Vref（PVref），在 PRB 中实现 

▪ CapSense ADC，通过单斜率 ADC 实现 

每个组件都包含数据手册。因此，要想了解组件的详细信息，请参考其数据手册中的内容。请访问 PSoC 模拟协处理

器组件数据手册网页，以获取 PSoC 模拟协处理器组件的数据手册列表。 

http://www.cypress.com/
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A532
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A532
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6 我的第一个 PSoC 模拟协处理器设计 

本节帮助您实现一个简单的基于传感器的 AFE 设计，并将其烧写到开发套件中。另外，也介绍了快捷了解使用 PSoC 

Creator IDE 来设计 PSoC（的技术）的详细步骤 

6.1 设计前准备 

6.1.1 您是否已经安装了 PSoC Creator？  

从 PSoC Creator 主页上下载并安装 PSoC Creator。PSoC Creator 3.3 SP2 和更高版本都支持 PSoC 模拟协处理器系

列器件 

6.1.2 您是否拥有一个开发套件？  

该设计是针对 CY8CKIT-048 PSoC 模拟协处理器的 Pioneer 套件设计的。该套件提供了与 Arduino™屏蔽和基板相兼

容的插座。它指定了五个板上传感器的特性， 包括一个 RGB LED、两个按键开关、一个赛普拉斯的 F-RAM™和

KitProg2 （即板上编程器/调试器和 USB-UART/I2C 桥接器）。 

6.1.3 您是否想查看正在操作的工程？  

若不想进行整个设计过程，则可以在 http://www.cypress.com/CE211283 网站上下载完整的代码示例工程。这样您可

以跳转到编译和编程步骤。 

6.2 设计概述 

该设计实现了一个简单的模拟调节电路，用于光度传感器。光度传感器的输出是一个较弱的电流信号，它与光照强度成

正比。图 6 显示的是用于调节和测量该电流信号的 PSoC Creator 原理图。  

图 6. 我的第一个 PSoC 模拟协处理器设计 

 

该设计通过使用互阻放大器（TIA， 它由一个运算放大器和各外部的无源组件组成）将光度传感器的电流输出转换为电

压信号。您可以在 PRB 模块中将 TIA 的参考电压设置为 1.20 V。使用 12 位 SAR ADC 测量 TIA 的输出，然后进行百

分比校准，以符合在 0 到 1 Klux 范围中的光照强度。校准后的百分比值便是 PWM 的占空比。连接到 PWM 输出的一

个 LED 用于表示与光照强度相对应的的亮度变化。 

注意： CY8CKIT-048 PSoC 模拟协处理器的 Pioneer 套件的电路板上已经装有所需光度传感器，并且它被连接到

PSoC 模拟协处理器上。因此，进行设计测试时，便不再使用额外的组件。 

http://www.cypress.com/
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
http://www.cypress.com/CY8CKIT-048
http://www.cypress.com/CE211283
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6.3 第一部分：创建设计 

本节将向您逐步介绍设计流程。本节内容指导您通过硬件和软件进行设计。 

注意： 这些指导假设您正在使用 PSoC Creator 3.3 SP2 或更高版本。整个开发过程与 PSoC Creator 后续版本的相同，

但是一些对话框可能不一样的。 

1. 创建一个新的 PSoC Creator 工程。 

a. 启动 PSoC Creator。 

b. 依次选择 File > New > Project，如图 7 显示。 

将出现创建工程窗口。 

图 7. 创建一个新的 PSoC Creator 工程 

 

2. 将 PSoC 模拟协处理器设置为目标器件，如图 8 所示。 

PSoC Creator 通过自动对指定开发套件或目标器件设置各种工程选项，从而加快开发过程。  

A. 点击 Target device（目标器件）。 

B. 在下拉框中选择 PSoC Analog Coprocessor 项。  

C. 然后点击 Next 按键。 

PSoC Creator 将 CY8C4A45LQI-483 选为 PSoC 模拟协处理器器件中的默认器件。该器件在 CY8CKIT-048 PSoC

模拟协处理器的 Pioneer 套件上。 

图 8. 选择目标器件 

 

A 

B 

C 

http://www.cypress.com/
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3. 选择 Empty Schematic，如图 9 所示。  

A. 点击 Empty Schematic 项。 

B. 然后点击 Next 按键。 

C. 在下一个对话框的 Workspace name 框中，输入工作区名称，如图 10 所示。一个工作区名称中包含了一个

或多个工程。 

D. 指定您工作区和工程的位置。 

E. 在 Project name 框中输入工程名称。工程名称与工作区名称可以相同，也可以不同。 

F. 点击 Finish。 

图 9. 选择原理图模板 

  

图 10. 工程命名和定位 

  

A 

B 

C 

D 

E 

F 

http://www.cypress.com/
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4. 工程的原理图默认打开，如图 11 所示。您可以在该原理图中实现硬件设计。请注意 Workspace Explorer 窗口中

的相关文件 TopDesign.cysch 。如果没有显示原理图，那么请双击该文件打开它。 

图 11. 原理图 

 

5. 由于您在步骤 3 中已经选中了“Empty Schematic”项，因此 Top Design 中没有数据。Component Catalog（组

件目录）窗口位于原理图画布的右侧，如图 11 所示。如果不显示组件目录，那么请依次选择 View > Component 

Catalog 以打开它。现在，您可以开始进行组件放置。 

6. 首先，请在原理图中创建一个互阻放大器（TIA）。从 Component Catalog 中选择某个运算放大器并放置（拖放）

到原理图中，如图 12 所示。您可以在 Analog 组，Amplifiers 子组中查找运算放大器。 

图 12. 运算放大器选择 

 

默认情况下，该组件的示例名称为 Opamp_1。使用各个默认属性（如中等功耗设置）来配置该组件。下一步，请

针对该应用更改配置。 

 

http://www.cypress.com/
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7. 双击运算放大器组件以配置它。请按照图 13 配置该组件。 

A. 将组件改名为“Opamp_TIA”。 

B. 请确保已经选择了 OpAmp 模式（默认设置）。 

C. 选择 Output to pin 选项，从而将运算放大器输出连接到某个引脚上。 

每个组件都有包含相关的数据手册，您可以在配置窗口中查看它，如图 13 所示。组件的数据手册提供了更多有关

组件配置、应用编程接口（API）和电气规格的详细信息。 

保留其他设置为其默认值。请参考组件数据手册以了解各种设置的作用。 

点击 OK 来使能这些设置的内容，并关闭该窗口。 

图 13. 运算放大器的组件配置 

 

8. 同样，放置 PVref 组件（位于组件目录的 Analog 组中）并配置它的参数，如图 14 所示。该组件指定 TIA 的参考

电压并将 SAR ADC 的负极输入设置为 1.20 V。 

A. 将组建改名为“PVref”。 

B. 将 Reference source 设置为 Bandgap (V) 1.20（默认值）。 

C. 将 Voltage reference (V)设置为 1.20 (tap 16)（默认值）。 

图 14. 可编程参考配置 

  

A 

B 

C 

A 

B
V C 

http://www.cypress.com/
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9. 放置 Opamp 组件（位于组件目录的 Analog 组，Amplifiers 子组中）并配置它的参数，如图 15 所示。通过该组件，

可以触发由 PVref 组件生成的参考电压。 

A. 将组件改名为“Opamp_Buffer”。 

B. 将 Mode 设置为 Follower。 

图 15. Opamp_Buffer 配置 

 

A 

B 

http://www.cypress.com/
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10. 放置 Scanning SAR ADC（位于组件目录的 Analog 组，ADC 子组中）并配置它的参数，如图 16 所示。 

A. 将组件改名为“ADC”。 

B. 将 Free-run scan rate (SPS)设置为 1000。 

C. 在“Vref select”框中选择 System bandgap voltage 项（1.200V）。测量范围为±1.2 V，同 SAR ADC 负极

输入上的电压相对应。 

D. 将 Number of channels 设置为 1，因为您只需测量 TIA 输出的值。 

E. 将 Input mode 设置为 Differential（默认）。 

图 16. SAR ADC 配置 — Configuration 选项卡 

 

A 

B 

C 

D 

E 

http://www.cypress.com/
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11. 放置 PWM 组件（位于组件目录的 Digital 组，Functions 子组中）。通过该组件，可以驱动 LED。请按照图 17 配

置该组件。 

A. 将组件改名为“PWM”。 

B. 将 Period value 中的值 选为 100。这样，您可以直接将 PWM 输出占空比的百分比的控制范围从 0 到 100%。 

C. 将 Compare 值设置为 90，以获得 90%的初始输出占空比。在运行过程中，您可以通过固件修改该值。 

PWM 输出的频率取决于时钟输入，更多有关它时钟输入的配置，请参考下一步。 

图 17. PWM 组件配置 

 

A 

B 

C 

http://www.cypress.com/


 
 

PSoC®模拟协处理器入门 
 

www.cypress.com 文档编号：002-12470 版本*A 16 

12. 放置 Clock 组件（位于组件目录的 System 组中）。通过该组件，可以为 PWM 组件提供时钟脉冲。将组件改名为

“Clock”，并保留默认频率为 MHz，如图 18 所示。由于上一步已经将 PWM 周期设置为 100，因此 PWM 的输

出频率将为 120 kHz。 

图 18. 时钟组件配置 

 

13. 放置和配置各引脚： 

首先，请放置并配置 TIA 输入的引脚。由于 TIA 是一个模拟输入，因此需要选择相应的模拟引脚组件（其位于组件

目录的 Ports and Pins 组中）。 

A. 将组件改名为“Pin_Sensor” 

B. 使能外部终端。这时， 您可以进行放置，并连接各个外部（片外）组件。原理图上的外部组件只用于说明目

的，并不影响您的设计。 

图 19 显示的是 Pin_Sensor 的配置。 

图 19. Pin_Sensor 组件配置 

 

接下来，放置其他模拟引脚组件，用于 TIA 输出（与 Pin_Sensor 组件相同）。将组件改名为“Pin_TIAOutput”，

并使能 External terminal（外部终端）项。 

A 

B 

http://www.cypress.com/
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放置一个数字输出引脚，用于驱动 LED。将引脚改名为“Pin_LED”并使能 External terminal 项，如图 20 所示。

保留其他默认设置。 

图 20. Pin_LED 配置 

 

14. 如上一步所述，原理图中各个片外组件都是可选的。您可以在组件目录的 Off-Chip 选项卡中查询这些组件，如图

21 所示。若想使用这些片外组件，请进行相应的放置，并设置其数值，如表 1 所示。 

图 21. 片外组件 

 

表 1. 引脚和外部组件配置 

组件 

组件目录  

选项卡 参数组 数值 

光电二极管 片外 二极管 – 

电阻 片外 无源 220 K 

电容 片外 无源 0.1 µF 

电阻 片外 无源 2.2 K 

LED 片外 二极管 – 

Vdd 片外 电源 – 

接地 片外 电源 – 
 

 

这样便完成了组件放置和配置。下一步是将各组件连接在一起。 

15. 选择连线工具（图 22）， 

（也可以按‘w’作为快捷键）。 

将各组件终端互连在一起，如图 6 所示。 

图 22. 连线工具 

 

http://www.cypress.com/
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16. 这时便完成了硬件设计，但还需要为引脚组件分配一个物理引脚。为您的开发套件选择物理引脚。 

A. 在 Workspace Explorer 窗口中，双击文件 My_First_Design.cydwr。 

B. 选择 Pins 选项卡。设计中所使用的各引脚出现在列表中。 

C. 为设计中的每个引脚组件选择您需要的物理引脚，如图 23 所示。 

图 23. 引脚分配 

 

如果您正在使用 CY8CKIT-048 PSoC 模拟协处理器的 Pioneer 套件，那么请按照表 2 设置引脚： 

表 2. CY8CKIT-048 的物理引脚 

引脚组件名称 物理引脚 

Pin_Sensor P2[4] 

Pin_TIAOutput P2[3] 

Pin_LED P1[4] 

 

A 

B 

C 

http://www.cypress.com/
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17. 完成硬件配置设置后，您可以继续添加固件代码。但，编写固件前，PSoC Creator 最好要生成所有与组件相应的

API 代码。请依次选择 Build > Generate Application，如图 24 所示。如果没有出现错误，则 PSoC Creator 会

生成几个代码文件，这些文件位于 Generated_Source 文件夹中，如图 25 所示。 

图 24. 生成应用 

 

在工作区中打开自动生成文件 main.c，如图 25 所示。 

图 25. 所生成的源文件 

 

http://www.cypress.com/
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将代码 1 中的代码编写到您工程的 main.c 文件中。该代码将实现以下操作： 

▪ 通过使用组件的 API 函数（如 Opamp_TIA_Start()）来初始化各组件， 

▪ 读取并筛选 ADC 转换结果 

▪ 将筛选出的 ADC 结果转换为百分比值 

▪ 使用计算出的百分比值更新 PWM 的占空比 

代码 1. main.c 

#include <project.h> 

#include "stdio.h" 

 

/* IIR Filter Coefficient */ 

#define FILTER_COEFFICIENT_ALS 8 

 

/* ADC Channel for ALS - Channel 0 */ 

#define ALS_CHANNEL 0x00 

 

/* ADC Counts at 1K lux illuminance, calculated based on the sensor TEMD6200FX01 datasheet */ 

#define ADCCOUNTS_1K_LUX 0x96 

 

int main() 

{ 

    /* Variables */ 

    int ADCResult, ADCFiltOut=0, ALSPercent; 

 

    /* Enable global interrupt */ 

    CyGlobalIntEnable;  

 

    /* Start the TIA */ 

    Opamp_TIA_Start(); 

 

    /* Start the Reference Voltage */ 

    PVref_Start(); 

 

    /* Start the Opamp buffer */ 

    Opamp_Buffer_Start(); 

 

    /* Start the SAR ADC; continuous conversions */ 

    ADC_Start(); 

    ADC_StartConvert(); 

 

    /* Start the PWM */ 

    PWM_Start(); 

 

    for(;;) 

    { 

        /* ADC scan rate is set to 1ksps */  

        /* Check if the ADC result is ready */         

        if(ADC_IsEndConversion(ADC_RETURN_STATUS)) 

        { 

        /* Get the sign extended 16 bit result with 11 bits of magnitude */ 

        ADCResult = ADC_GetResult16(ALS_CHANNEL); 

             

        /* IIR Filter - sample rate: 1 ksps */ 

        /* Weight on the new sample is 1/8, and weight on the previous filter output is 7/8 */ 

        ADCFiltOut = (ADCResult + (FILTER_COEFFICIENT_ALS - 1) * ADCFiltOut) / 

                     FILTER_COEFFICIENT_ALS; 

 

        /* Convert filtered data into percentage. Filter output is multiplied by -1, so that 

           the percentage value is directly proportional to the ambient light illuminance */ 

        ALSPercent = (-1*ADCFiltOut*100) / ADCCOUNTS_1K_LUX; 

 

        /* Limit the values between 0 to 100 to express the ambient light  

        illuminance in percentage for a given operating window (0 to 1 Klux)*/ 

        ALSPercent = (ALSPercent > 100) ? 100 : ((ALSPercent < 0) ? 0 : ALSPercent); 

 

        /* Update PWM duty cycle. The LED has an active low connection on the CY8CKIT-048 kit. */ 

        PWM_WriteCompare(PWM_PWM_PERIOD_VALUE - ALSPercent); 

        } 

    } 

} 

 

http://www.cypress.com/
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18. 如果您没有遵循设计的整个流程而跳到这一步，请执行下列操作： 

A. 在网页 http://www.cypress.com/CE211283 上下载 CE211283.zip 代码示例文件，然后将其解压到您的电脑中

容易找到的位置。 

B. 下载并安装 PSoC Creator，如第 6.1.1 节的内容所示。 

C. 打开 CE211283.cywrk 文件。 

D. 确认该工程引脚分配与您的开发套件（DVK）互相匹配。更多有关 CY8CKIT-048 的信息，请参考表 2。 

E. 依次选择 Build > Build <project name>，如图 26 所示。如果没有出现错误，则该工程已经编译好，并准备

好编程目标 DVK 目标板。 

图 26. 编译工程 

 

http://www.cypress.com/
http://www.cypress.com/CE211283
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6.4 第二部分：编程器件 

1. 将 DVK 连接到您电脑上的 USB 端口。 

2. 确认 PSoC Creator 和您的 DVK 之间的连接状态。为进行这一步骤，请先选择 PSoC Creator 菜单项：依次点击

Debug > Select Debug Target， 如图 27 所示。  

图 27. 选择调试目标 

 

A. 将显示“Select Debug Target”对话框，如图 28 所示。点击您的目标 DVK 板（PSoC Creator 支持多个

DVK 连接）。 

B. 点击 Port Acquire 项。 

图 28. 配置目标板 

 

A 

B 
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3. 将 PSoC 连接到您的目标 DVK 板上。请参见图 29。 

A. 点击 PSoC 模拟协处理器。 

B. 点击 Connect。“Target unacquired”（未获取调试目标）信息将会更改为“Target acquired”（已获取调

试目标），并且按键的标签会更改为“Disconnect”（断开）。 

C. 点击 OK，关闭该对话框。 

PSoC Creator 已连接到目标 DVK 和 PSoC 器件，您现在可以对 PSoC 器件进行编程。 

图 29. 连接到 PSoC 模拟协处理器 

 

4. 为了编程 PSoC 模拟协处理器，请依次选择 Debug > Program，如图 30 所示。 

图 30. 编程 PSoC 

 

A 

B 

C 
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5. 开始编程。您可以在窗口左下角的 PSoC Creator 状态栏上查看编程的状态，如图 31 所示。 

注意： 您也可能看到以下警报信息：“This programmer is currently out of date”（当前该编程器已过期）。更

多有关如何升级您的编程器固件的信息，请参考套件文档中的 KitProg 用户指南。 

图 31. 编程状态 

 

6.5 第三部分：测试设计 

请按照以下步骤进行测试设计： 

1. 将 CY8CKIT-048 DVK 板的 USB 端口连接到 PC 上，如图 32 所示。 

图 32. CY8CKIT-048 DVK 

 

2. 用手遮挡光度传感器（ALS），并观察红色 LED 的亮度变化。建议您在光照充足的地方进行该测试，从而使结果

最好。 

7 总结 

本应用笔记提供了 PSoC 模拟协处理器的详细信息以及创建第一个设计的指导。它还提供了额外资源的概览，以便加

快您熟悉该设备的过程。 

ALS 

LED 

http://www.cypress.com/
http://www.cypress.com/CY8CKIT-048
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8 相关应用笔记和代码示例 

表 3 列出了选定的系统级和通用的应用笔记，用以进一步了解 PSoC 和 PSoC Creator。 

表 3. 通用和系统级应用笔记 

文档 文档名称 

AN86233 PSoC 4 和 PSoC 模拟协处理器的低功耗模式以及降低功耗的技术 

AN88619 PSoC 4 硬件设计的注意事项 

AN73854 PSoC 3、PSoC 4 和 PSoC 5LP：Bootloader 的简介 

AN89056 PSoC 4 — IEC 60730 Class B 和 IEC 61508 SIL 安全软件库 

 

表 4 针对器件的各种特殊外设和应用列出了相关的应用笔记（AN）和代码示例（CE）。 

表 4. PSoC 模拟协处理器特性的相关文档 

文档 文档名称 

可编程模拟模块 

AN211294 使用 PSoC 模拟协处理器实现 AFE 

AN60590 PSoC 3、PSoC 4 和 PSoC 5LP — 使用二极管时的温度测量 

AN70698 PSoC 3、PSoC 4 和 PSoC 5LP — 使用电阻温度检测器（RTD）时的温度测量 

AN66477 PSoC 3、PSoC 4 和 PSoC 5LP — 使用热阻时的温度测量  

CE211252 连接 PSoC 模拟协处理器和光度传感器 

CE211301 连接 PSoC 模拟协处理器和 PIR 运动传感器 

CE211305 连接 PSoC 模拟协处理器和电感式接近感应传感器 

CE211321 连接 PSoC 模拟协处理器和热阻 

CE211322 连接 PSoC 模拟协处理器和湿度传感器 

CPU 和中断 

AN89610 PSoC 4 和 PSoC 5LP ARM Cortex 代码优化 

AN90799 PSoC 4 中断 

I/O 

AN86439 PSoC 4 和 PSoC 模拟协处理器 — 使用 GPIO 引脚 

CapSense 

AN85951 PSoC 4 和 PSoC 模拟协处理器 CapSense®设计指南 

感应 基于 CapSense 的接近感应 

Bootloader 

AN86526 PSoC 4 和 PSoC 模拟协处理器 I2C Bootloader 

AN68272 PSoC 3、PSoC 4、PSoC 5LP 和 PSoC 模拟协处理器 UART Bootloader 

Segment LCD 

AN87391 PSoC 4 Segment LCD 驱动程序 

编程工具 

AN84858 使用外部微控制器对 PSoC 4 进行编程（HSSP） 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an86233-psoc-4-low-power-modes-and-power-reduction-techniques?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an88619-psoc-4-hardware-design-considerations?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an73854-psoc-3-psoc-4-and-psoc-5lp-introduction-bootloaders?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an89056-psoc-4-iec-60730-class-b-and-iec-61508-sil-safety-software?source=search&cat=technical_documents
http://www.cypress.com/an211294
http://www.cypress.com/documentation/application-notes/an60590-psoc-3-psoc-4-and-psoc-5lp-temperature-measurement-diode
http://www.cypress.com/documentation/application-notes/an70698-psoc-3-psoc-4-and-psoc-5lp-temperature-measurement-rtd
http://www.cypress.com/documentation/application-notes/an66477-psoc-3-psoc-4-and-psoc-5lp-temperature-measurement
http://www.cypress.com/CE211252
http://www.cypress.com/CE211301
http://www.cypress.com/CE211305
http://www.cypress.com/CE211321
http://www.cypress.com/CE211322
http://www.cypress.com/documentation/application-notes/an89610-psoc-4-and-psoc-5lp-arm-cortex-code-optimization
http://www.cypress.com/documentation/application-notes/an90799-psoc-4-interrupts?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an86439-psoc-4-using-gpio-pins?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an92239-proximity-sensing-capsense
http://www.cypress.com/documentation/application-notes/an86526-psoc-4-i2c-bootloader?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an68272-psoc-3-psoc-4-and-psoc-5lp-uart-bootloader?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an87391-psoc-4-segment-lcd-direct-drive?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an84858-psoc-4-programming-using-external-microcontroller-hssp
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